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This is an initial introduction to the fundamental concepts and tools that you need to efficiently use MicroStation 
CONNECT Edition and applications based on it such as AECOsim Building Designer. 

It is based on an earlier version written for V8i applications. 

The two versions are presented side by side, V8i on the left, CONNECT Edition on the right. 

• Where the right column is empty it indicates that CONNECT Edition works in the same way as V8i. 
• Where the left column is empty it indicates something new or different in CONNECT Edition. 

Conventions: 

• Keystroke sequences are indicated by the > symbol, e.g. Esc then 4 will be shown as Esc > 4. 

• Keystroke combinations will be shown by the + symbol, e.g. Ctrl + O (capital letters are used for clarity, either case will 
take effect). 

• For help use the Help menu. Press F1 for help at any time, the help document will normally open at a page relevant to 
the active command. 

 

Searching the Bentley Communities for MicroStation and AECOsim Building Designer wikis and forums for more information is 
highly recommended 
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V8i - Opening MicroStation and Choosing Your Project 

It is always best to open MicroStation from a shortcut rather than by double clicking a file. This is because there are a 
number of settings that are project specific such as paths to reference files, default output locations and project 
specific libraries. 

On opening MicroStation you see a variation of the File Open dialog: 

 

The three pick lists at the lower right are unique to this dialog. User and Interface are generally set at the system 
level so the only choice that needs to be made is the Project. The most common symptom of selecting the wrong 
project is that reference files will show up as missing, highlighted in red. Where AECOsim Building Designer is in use 
this is even more critical as there will be a project specific dataset.  

The Project menu is populated by Project Configuration Files, these are usually managed by the system 
administrator. 

Once MicroStation is open use File menu > Close to return to this dialog.  

File menu > Open will take you to a dialog that does not have these options 

CE- Opening MicroStation and Choosing Your WorkSet 

It is always best to open MicroStation from a shortcut rather than by double clicking a file. This is because there are 
many settings that are WorkSet specific such as paths to reference files, default output locations and WorkSet 
specific libraries. 

Note for V8i users: a V8i Project is now a WorkSet, WorkSets are contained in WorkSpaces. Note that it is even more 
important in CONNECT Edition that the correct WorkSet is selected before working on your designs. 

On opening MicroStation you are brought to the Work Page where you can select your WorkSpace, WorkSet and 
open or create a file. 

It is even more important in CONNECT Edition that the correct WorkSet is selected before working on your designs. 

The Work Page shows recently uses WorkSets on the left, recent files in the active WorkSet and their properties in 
the centre and the WorkSet properties on the right. See the CONNECT Edition help page tilted ‘Using Work page’ for 
more information on the features available here. 

 

Creation of WorkSpaces and WorkSets is normally manged by a CAD system administrator. However for smaller 
organisations we have wizards that can be used to create both. Please see the help topics ‘Create WorkSpace Dialog’ 
and ‘Create WorkSet Dialog’ for more information. 
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Click Browse to (or Ctrl + O) to open a file, note the File and Directory (aka Folder) history drop down menus. A well 
configured system will offer a DGN folder for the selected WorkSet: 

 

Once MicroStation is open click the ribbon File tab to go to the Backstage where you can open other files. Selecting 
the Close item will return to the Work Page. 

 

Ctrl + N will open the new File dialog.  
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File Formats 

MicroStation’s file format is .DGN. 

.DGN files can be 2D or 3D. This simplifies life when working on 2D only information, no worries about the Z depth. 

MicroStation can open, edit or create .DWG files in Autodesk RealDWG format. The Autodesk RealDWG libraries 
were built into MicroStation versions from V8i Select Series 1 onwards. Bentley maintain compatibility with DWG 
versions every time Autodesk change the format. 

MicroStation can import/export or reference a number of other formats including 3DS, SketchUp, and Rhino. 

File Open: 
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The Mouse  

MicroStation used to be preferred by many people because of the intuitive nature of the icon driven interface. This 
did however require a lot of mouse mileage. 

Improvements and consolidation of the interface, along with the introduction of context sensitivity, have done a lot 
to reduce this mileage. Most recently several features have brought many tools to the tip of the mouse cursor. 

V8i Only - Mouse Right-click Options 

When you first use MicroStation V8i if/when asked to set right-click behaviour, choose Click for Reset, this is the 
optimum setting for best use of MicroStation. 

 

Mouse Buttons 

Please remember this MicroStation terminology, it is used extensively in the help documents as well as these notes: 

• Left Mouse button = Data 
• Right Mouse button = Reset 
• Left + Right Mouse buttons = Tentative 

If you have used previous versions of MicroStation you will be used to using the Middle Button as Tentative to snap 
with. AccuSnap does virtually all of your Tentative snapping work for you so don’t change your Button Assignments. 
If Tentative is remapped to Middle Button the various assignments that involve the middle button are changed. 

Middle button pans by dragging as default, hold it down and drag.  

(In these notes Key + middle button indicates clicking or holding down the mouse wheel. Key + mouse wheel 
indicates rolling the mouse wheel) 

Leave Tentative as the default Data + Reset combination. 

Zoom in and out using mouse wheel. 

Alt + mouse wheel to Pan Left/Right 
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Shift + mouse wheel by default is the Pan with Zoom action, an unpredictable combination that usually ends with the 
model flying out of view somewhere. Try changing this combination to Pan Up/Down. 

From MicroStation’s Workspace menu pick Preferences > Mouse Wheel > Shift + Wheel = Pan Up/Down: 

 

Shift + Data (left button) to pan around with a direction indicator… try it 

Also refer to the Right-clicking document that lists the various menus available by right-clicking, i.e. Key(s) + Reset. 

In 3D Only 

Rotate view around a point. This has the following steps: 

Alt + middle button produces a fine white cross, drag this around with the mouse until it snaps to a suitable point 
around which to rotate the model. While being dragged the cross will thicken, it will snap to points with AccuSnap. 
Once snapped the cross will revert to fine thickness and mouse cursor will revert to the navigation icon. Then hold 
down Data and drag the view around. Try this out, it’s easier done than described. 

 

Shift + Data to pans around the active plane (i.e. in 2D) with a direction indicator. 

 

 

CONNECT Edition Preferences dialog: 
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Getting Started 

Using every MicroStation tool involves a basic sequence: 

Pick the tool, adjust the settings, and follow the prompts and Draw... 

V8i - Pick your Tool 

Pick your tool by using the Position Mapping keystrokes, right-click menus, Task Navigation Panel, Toolboxes, Menus 
or F-keys. See sections below for more on these methods. For many tools their use is fairly self-evident once you 
have established efficient ways of accessing them and become used to the basic sequence. 

Adjust the Settings 

Adjust the Settings in the Tool Settings dialog (see below). 

Prompts in the Status Bar 

The Status Bar at the bottom left of the MicroStation application window tells you what command or tool you are 
currently using and prompts for the next input from you. Always look out for this and refer to it when using 
unfamiliar tools or when in doubt what to do next. This is a lot quicker than guessing! 

 

 

 

 

 

CE - Pick your Tool 

Pick your tool by using the Ribbon, pop-up menus/keystrokes or F-keys. See sections below for more on these 
methods. For many tools their use is fairly self-evident once you have established efficient ways of accessing them 
and become used to the basic sequence. 

 

 

 

 

 

CONNECT Edition Status Bar 
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V8i - Focus 

Focus is where input from the keyboard will take effect. MicroStation has several points where keyboard input can 
be applied, you need to be sure you are at the right point before entering your input keystrokes. It is important to be 
familiar with the focus scheme: 

icon name keystroke What it does 

 

Home. Esc or F12 With the focus at Home you can use the Positional 
Mapping keys. 

 

AccuDraw. Spacebar or 
F11 

This gives access to all of the familiar AccuDraw 
shortcuts and a series of new ones. 

 

Tool 
Settings. 

F10 Pressing F10 takes you to the Tool Settings dialog. Once 
there you can use the up/down arrow or Tab keys to 
move up and down the available options, Spacebar to 
display pop-up option menus followed by up/down arrow 
to select from the pop-up menu. 

 

Key-in F9 or Enter Opens the Key-in dialog at the cursor, moving the mouse 
away from the Key-in window closes it. 

 

To move between inputs press Esc followed by the appropriate focus key.  

If in doubt about where your focus lies, press Esc then the appropriate key to move away from Home focus. 

CE - Focus 

Focus is where input from the keyboard will take effect. MicroStation has several points where keyboard input can 
be applied, you need to be sure you are at the right point before entering your input keystrokes. It is important to be 
familiar with the focus scheme: 

Icon Name Keystroke What it does 

 

Home. Esc or F12 With the focus at Home you can use the Keyboard 
Shortcuts and, if enabled, Position Mapping keys. 

 

AccuDraw. F11 This gives access to all of the familiar AccuDraw 
shortcuts and a series of new ones. 

 

Tool 
Settings. 

F10 Pressing F10 takes you to the Tool Settings dialog. Once 
there you can use the up/down arrow or Tab keys to 
move up and down the available options, Spacebar to 
display pop-up option menus followed by up/down arrow 
to select from the pop-up menu. 

 

Key-in F9 or Enter Opens the Key-in dialog at the cursor, moving the mouse 
away from the Key-in window closes it. 

In CONNECT Edition when focus is in other dialogs the icon for that dialog will generally be displayed in the Status 
Bar 

To move between inputs press Esc followed by the appropriate focus key.  

If in doubt about where your focus lies, press Esc then the appropriate key to move away from Home focus. 
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CE - Tool Pop-ups 

Spacebar 

The Spacebar activates the Popups dialog.  

  

This contains: 

• Top row: frequently used Ribbon Group shortcuts from the Home tab 
• Middle row: the most frequently used tools 
• Bottom row: other frequently used Ribbon Groups 

This popup can be customised. 

Q or [ 

These keys open popup menus with different 
selector characters suited to left or right hands: 

e.g.: [ followed by P will start the Move tool 

(Note: If Position Mapping is enabled, described in 
Appendix B, the Q shortcut will be applied to the 
indicated Ribbon Group.) 
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V8i - Using Tools 

Toolboxes and Task Navigation 

Every tool in MicroStation has a toolbox on the Tools menu: 

This menu is context sensitive. Tools that only apply to 3D files are greyed 
out in a 2D file (as are other menu items). 

The other main location for Tools is the Task Navigation Panel. This 
contains the most commonly used tools grouped under workflow Tasks, 
e.g. Drawing: 

 

 

The view of the tools in Task Navigation can be changed using the icons in 
the tile bar of each Task. These settings can be different for each Task and 
will be remembered in your user preferences. 

CE - Using Tools  

The Ribbon 

CONNECT Edition applications have introduced the Ribbon interface. This adheres closely to Microsoft standards for 
Ribbon interfaces providing a feel that will be familiar from other applications such as Microsoft Office. The basic 
techniques for using the Ribbon are similar to those in Microsoft Office and other Ribbon based user interfaces. 

Here are a few tips that apply to all Power Platform products: 

Changing Ribbon Workflow 

At the top right of the Ribbon we have added the ability to move between a number of different Ribbon layouts, that 
we call Workflows, by picking the Workflow name from the pop-down menu. 

 

To speed this up, following V8i design principles of bringing actions to your mouse cursor, press a key to pop this 
menu up at the cursor, then press the number of the Workflow that you want: 

 

The key to open this menu varies by region/keyboard, some examples are listed below. 

Region Keystroke 
US (QWERTY) \ 
UK (QWERTY) # 
France (AZERT) * 
Germany (QWERTZ) # 
Denmark (QWERTY) ' 
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F2 

Displays the KeyTips for Ribbon Tabs and Quick Access Toolbar (QAT) 

 

Press the appropriate letter to activate the desired Ribbon Tab or number (combination) to activate a QAT tool. 

ALT + <Letter> 

These combinations can be used as an alternative to F2 to open tabs or go to the backstage. For example, Alt+F can 
be used to open the Backstage and Alt+H can be used to switch to the Home tab. These shortcuts are shown in the 
tooltips for all ribbon tabs. 

 

F3 

Displays the KeyTips for the open Ribbon Groups: 

 

The KeyTips displayed in response to F3 have two conditions, those shown above are generated when Position 
Mapping is on, note how the KeyTips in each group start with the assigned Position Mapping letter followed by a 
sequential number (this is because the Auto-Generate KeyTips toggle is turned on and locked once Position mapping 
is on). 
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When If Position mapping is off (the default) the KeyTips follow a different pattern, shown below, based on the 
Ribbon Group name and the tool name. I feel that the Position mapping KeyTips are more readable. 

 

Clearing the KeyTips 

The KeyTips will clear once a tool is selected, to clear without selecting a tool press Esc or right-click to Reset. 

F4 

Press F4 to search for tools in the Ribbon, Backstage, and Quick Access Toolbar: 

 

Select the Show/Hide Details option to see additional information about the listed tools  
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Quick Access Toolbar 

The Quick Access Toolbar (QAT), like Microsoft Office, provides an easy way for individuals to have their most used 
tools immediately to hand, just click the down arrow at the right hand end then pick Customize Quick Access 
ToolBar: 

 

Show/Hide Ribbon Tools 

 

Similar to Toolboxes in V8i applications right-clicking on a Ribbon Group displays a pop-up menu listing all of the 
tools where they can be ticked on/off. Any changes made are stored in each user's preferences.  
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Ribbon Preferences 

The Ribbon preferences offer controls for the size and display of Ribbon items, the default Ribbon Size, Medium, 
displays 24 x 24 pixel icons for the smaller buttons. 

 

The Position Mapped Groups option is discussed in context on Bentley Communities in CONNECT Edition - Using 
Position Mapping to get to Tools Really Quickly!. 

Show Popup KeyTip Hints controls whether KeyTips are initially shown for Ribbon Group Popups. This may be useful 
to gain initial familiarity, but as pressing ALT when the popups are open shows the KeyTips this can generally be left 
unchecked. 

Ribbon Key-ins 

There are many Ribbon related key-ins, some already in use in the UI. They can be very helpful when customizing the 
Ribbon or be assigned to Function key combinations or shortcuts. A few are listed below: 

RIBBON GROUPPOPUP 

Pops up a ribbon group at the cursor. The parameter to this key-in is the path of the group, e.g. 
Drawing\Home\Primary 

RIBBON SETWORKFLOW 

Switches to a given workflow. The parameter to this key-in is the name of the workflow, e.g. Drawing 

RIBBON ACTIVETABKEYTIPS 

Activates the KeyTips for the active tab. This is assigned to <F3>, by default. 

RIBBON MENU WORKFLOW 

Pops up a menu containing the workflows 

  

https://communities.bentley.com/other/old_site_member_blogs/peer_blogs/b/marc_thomass_blog/posts/connect-edition-using-position-mapping-to-get-to-tools-really-quickly
https://communities.bentley.com/other/old_site_member_blogs/peer_blogs/b/marc_thomass_blog/posts/connect-edition-using-position-mapping-to-get-to-tools-really-quickly
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RIBBON MENU TABS 

Pops up a menu containing the tabs within the active workflow 

TASK MENU 

Pops up a menu containing the available tasks 

Other ribbon key-ins can be explored in the Key-in Browser by typing “ribbon”. 

Additonal Information 

Look in the top level topic "The Ribbon" in CONNECT Edition help documents. 
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Tool Settings 

The Tool Settings dialog floats or can be docked. Docking it is not a good idea as this generates a huge blank grey 
area! 

The name of the Tool Settings dialog will echo the currently active tool: 

 

  

The size and content will vary dramatically depending on the options available for the active tool. 

• If the Tool Settings dialog is not visible press F10 to bring it back. 
• Use the AccuDraw shortcut Ctrl + Spacebar to bring it to your mouse cursor. 

The Tool Settings are crucial; virtually every tool has additional settings that allow you to get the result that you 
want. 

Some are very obvious; Place Circle for example, gives 
you options for the placement method: Center; Edge; 
Diameter, amongst other things. 

 

 

Others are more extensive such as Element Dimensioning. 

 

 

CONNECT Edition dialogs: 
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Here there is a range of dimensioning methods that have been consolidated into one tool, rather than a whole series 
of separate tools as in earlier versions of MicroStation. Also Element Dimensioning is a smart tool that will present 
different options according to the element being dimensioned. 

 

On the left, linear 
dimensioning. 

On the right radial 
dimensioning.  

 

 

The tool settings switch between these automatically going to radial when you dimension an arc, circle or ellipse. 

Always look for the little black arrows on the Tool Settings (and other dialogs), these pop-out additional options as 
shown above.  

The collapsed Element Dimensioning Tool Settings dialog looks like this: 

 

 

CONNECT Edition dialogs 
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Popset 

The Tool Settings dialog can also be made to hide using the PopSet option. PopSet will automatically hide the Tool 
Settings dialog if you need to draw in the part of the screen it is occupying. Right-click on the PopSet icon to see the 
PopSet options,  

 

by default they are set as shown here, the timings and hide border can be changed to suit your own preferences if 
desired. The Hide Border is the zone around the dialog that is sensitive to the mouse. When the mouse enters this 
zone slowly the Tool Settings will be hidden. 

  

Leave the Auto-Position Tool Settings box unticked for best behaviour by PopSet. 

If the PopSet icon is not visible right-click on the Primary Tools and tick PopSet. 

 

PopSet CE 

PopSet is not included in the Ribbon by default, press Ctrl + T to open the Toolboxes dialog, then scroll down to 
PopSet, tick the box and click OK. Dock the PopSet toolbox in a convenient place. 

 

Behaviour is the same as V8i. 

For more modern higher resolution monitors change the Hide Border to a higher value say 30 or 40. 
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Element Selection 

Quick Selection methods: 

• Drag with the Data button (Left button) from Left to Right to select elements within the shaded marquee. 
• Drag with the Data button (Left button) from Right to Left to select elements overlapping the shaded 

marquee, note the marquee will be dotted in this case. 

(Note that both of these will be affected by the mode selected in Element Selection Tool Settings, see below) 

Right-click and hold on the drawing background for a pop-up menu including: Select All, Select None (very useful!) or 
Select Previous. 

The Element Selection Tool Settings have two rows: 

• The top row is the Method, how you select. 
• The bottom row is the Mode, what you select. 

Using appropriate combinations of these options can really speed 
things up. 

For example: 

If you want to select everything in an area apart from one or two elements, set the mode to New or Add, Drag + Data 
over the elements. Then set Method to individual and Mode to Subtract and pick those one or two elements to 
remove them from the selection. 

Or 

Select the one or two elements then change the Mode to Invert and then Drag + Data across the whole area. 

Handles 

There are several new functions available using Handles in V8I. The only one that is really useful is to modify text. 

Alternate Text Handles 

You should notice that you have two types of handles for text in V8I. The “normal” blue square handles and the 
“alternate” green circle handles.  

• If you select a green circle handle you can modify the line length of the text element and dynamically 
change the word wrap of the paragraph. 

• If you select a blue square handle you can alter the size of the text block proportionally, however you have 
no immediate control over the text size so avoid using this. If you change a block size you can then match 
the modified text to the active text settings. A better sequence would be to match the text size then alter 
the proportions of the block with the green circle handles. Note that AccuDraw can be used in conjunction 
with handles to maintain alignments. 

• Having selected a block of text you can use the ALT key to toggle between the “normal” and “alternate” 
handles, although this has the limitation already described 

 

Element Selection operation in CONNECT Edition is the same as V8i. 

We have added a Material tab to the expanded Tool Settings dialog: 
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Snapping 

The snaps menu is accessed either from the Settings 
menu > Snaps 

or 

By clicking (data button) on the snaps icon in the status 
bar. 

Click (data button) on a snap mode to set it for the 
next action. It will then revert to its previous setting. 

Shift + Data on a snap mode to lock it to a new setting. 

The second menu shows Keypoint is current snap 
mode with Center as the locked mode. Once the next 
snap operation is complete, the snap mode will revert 
to Center. 

  

Multi-snaps: 

Click on the Multi-snaps item (highlighted above) to 
open the multi snaps settings window. 

You can tick any of the snap modes listed. They will 
apply in order of priority as listed. Each snap mode can 
be moved up or down the list to suit your preferences. 

Snap preferences are now saved per user so the snaps 
will remain set as you left them as you move from file 
to file.(In previous versions they were saved in each 
file.) 

  

 

Snapping CE 

The snaps menu is accessed 
by clicking (data button) on 
the snaps icon in the status 
bar. 

Click (data button) on a snap 
mode to set it for the next 
action. It will then revert to 
its previous setting. 

Click the Default Snaps pop-
up to select the required 
default snap from the list. 

Shift + Tentative (left + right 
buttons) to pop-up the Snaps 
tool panel at the cursor 

 

 

Multi-snaps: 

Click on the Multi-snaps icon 
(highlighted above) to open 
the multi snaps settings 
window. 

You can tick any of the snap 
modes listed. They will apply 
in order of priority as listed. 
Each snap mode can be 
moved up or down the list to 
suit your preferences. 
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AccuSnap 

AccuSnap is an essential tool that brings a range of snap functions to your cursor automatically. 

AccuSnap is turned on and off from this dialog. 
Settings menu > Snaps > AccuSnap. 

Working with AccuSnap off is usually a huge waste 
of time, don’t do it!  

The default settings work quite well but can be 
tweaked to suit your preferences. 

Enable for Fence Create allows AccuSnap to work 
with Fences. 

Hold down Shift + Ctrl to turn AccuSnap off 
temporarily if you want to manually snap to 
something. Also use to enable for Fence Create if 
you have not ticked Enable for Fence Create 

 

The Elements tab offers options for what AccuSnap 
identifies. In complex files you may wish to turn 
some of these off. 

Finding Elements by filled interior is a new ability in 
V8I. 

Sort hits by element class prioritises Primary 
elements over Constructions, then Patterns and 
Dimensions so should be left on. 

 

Here are some examples of AccuSnap in action locating keypoints. 

   

The icon next to the yellow cross shows the current snap mode. If you are using a multi-snap this icon will vary as the 
available snap points are located. 

 

This is identical in CONNECT Edition. 
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Right-clicking 

Right-click is set by default to Reset (aka Cancel, reject, stop) Reset is used throughout this document. 

On the drawing background  

Reset and hold:  

Brings up this Pop-up tools menu at 
the cursor 

 

On the drawing background  

Shift + Reset and hold: 

Brings up a View Control menu at the 
cursor 

 

 

 

Right-clicking CE 

Offers more options for Reset and Hold: 

 

Offers a visual palette for Shift + Reset and hold: 
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On an Element: 

Alt + Reset  

opens Quick Info 

 

Right-click on the grey area at the 
bottom of this dialog to turn on or off 
the attributes displayed. 

 

On the drawing background  

Ctrl + Reset and hold: 

Brings up the Main Tool Frame at the 
cursor 

 

Ctrl + Shift + Reset: 

Opens the current Task menu at the 
cursor. The tasks displayed will vary 
depending on which task panel is 
active. 

 

 

These three combinations are not assigned in CONNECT Edition.  
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Element Information 

The Element Information dialog is a powerful tool not only for establishing the current state of elements but also for 
making changes. It has the great advantage when making changes of enabling you to be sure of the current state 
before changes are applied. 

You can get at it either from the Primary Toolbox or by pressing Ctrl + I. 

The quickest sequence is to select one or more elements then press Crtl + I. 

If you select multiple elements they will be listed at the top of the dialog: 

The selection will be highlighted, in the various sections below some attributes will be shown as “Varies”. This is very 
useful for identifying inconsistencies.  

Clicking on an individual element in the list will show all the attributes for that element. 

Any attribute that is shown in black can be modified either by over-typing or by picking from a pop-down list. If over-
typing does not work use the pop-down, this operation of this dialog is not totally consistent yet.  

Where this comes in really useful is for modification of several or many elements. 

Properties (V8i Element Information) 

In CONNECT Edition Element Information is known as Properties. 

The behaviour is similar, the look has been updated: 
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Example: 

• Place some text elements at varying angles then select them all. 
• Press Ctrl + I 
• Note that in the Geometry section the angle “Varies”. 

 
• Double-click to select **Varies**, type 30 then Enter.  
• All the selected text items will be rotated to 30 degrees. 

Now draw three random diameter circles try modifying their attributes. 

Note: for circles to remain circular both primary and secondary axes have to be the same, there is no attribute for 
radius. 

If too much information is displayed you can right-click on a field to Hide it or, right-click on the grey background of 
the dialog and turn things on and off from the pop-up menus. To see the grey background, either expand the dialog 
or collapse some of the sections. On the basis that you never know when things will come in handy I leave these 
alone most of the time. 
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The AccuDraw Compass and the AccuDraw Window 

In most instances AccuDraw replaces the need to use several manipulation commands. It may require perseverance 
to become familiar with the shortcuts and exact syntax of some operations. 

AccuDraw adds two features to the interface:  

• A graphic indicator called the "compass" at any active data point on a drawing. 

   
• A precision input window, the AccuDraw window, with fields for entry of x,y (and z in 3d drawings) co-

ordinates or polar (distance,angle) co-ordinates as appropriate. 

  

The active field will be determined by the cursor direction/location relative to the compass. For example, move the 
cursor in the x direction, the x field will become active automatically, just type in the dimension and click the left 
mouse button.  

Keyboard short cuts offer single key operation when the focus is in the AccuDraw window (focus = highlighted field 
or button). With AccuDraw in focus press ‘?’ to see a list of AccuDraw shortcuts, see below for more on these. 

Starting AccuDraw  

AccuDraw is set to be on by default in user preferences. 

If it has been turned off click the AccuDraw button in the Primary Toolbox. 

 

Controlling the Compass 

The Compass operates in two modes, co-ordinate and polar. In co-ordinate mode x and y dimensions are input. In 
polar mode angle and distance are input. 

Switching from one mode to the other is achieved by pressing the space bar. 

By default the compass will rotate as elements are drawn so that the angles are always relative to the last element. 
This only becomes apparent when elements are placed at non-orthogonal angles. 

The compass can be rotated back to x,y orientation to the view by pressing V, i.e. y vertical, x horizontal to the right. 
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Basic Drawing with the Compass  

Try drawing a line with AccuDraw on. At the start of the line the compass appears. Notice that when the cursor is 
within about 3° of the x or y axes the line will snap to the axis. 

When the line is snapped to an axis, press Return. The line will then be locked to that axis, its length can be set either 
by keying in a dimension or by snapping to another element, note that the line remains on axis wherever the 
element being snapped to is located. 

Pressing X or Y will lock the current value entered into the AccuDraw window X or Y fields. This value can either be 
typed in or obtained by snapping to an element. 

AccuDraw remembers the last dimension you used, draw a line, then another and watch for the grey bar that 
appears when you get to the previous length: 
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AccuDraw's Shortcuts 

These are some of the most useful standard Shortcuts: 

Enter Smart Lock 

Press return/enter key to lock elements onto the AccuDraw axes. For example, once return/enter is pressed a line 
will remain locked on the selected axis regardless of the mouse position. 

Space Change Mode  

Press Space bar to switch from x y z co-ordinates to polar (angle and distance) co-ordinates. 

View Rotation 

V View Rotation 

Press V to rotate the AccuDraw compass back from an angle to orthogonal xy orientation aligned with the view. Use 
V when the view has been rotated. 

T, F and S Rotation 

In 3D rotate the compass to Top, Front and Side planes with these keys. In 2D T will rotate to the true XY. Note that if 
the 2D view is rotated this will be different to the View orientation. 

E Cycle Rotation 

In 3D press E repeatedly to cycle through the rotations. 

O Set origin 

Using the Offset "O" function 

Press O to move the origin from a snap point or data point. To use this, snap to a point, then press O (not zero), you 
will then be able to input dimensions using AccuDraw to move the origin (or start point) of the next step in the 
operation which you are performing. 

This function can replace many operations where an element is initially located by snapping to an existing element 
and then moved by distance to a new position. It will be equally useful in many other situations. The following simple 
example will explain: 

The sequence is: 

• Start AccuDraw. 
• Select the tool which you wish to use, Place Block for example. 
• Snap to the first point. 
• Then before you do anything else, press O (the letter not the number, it's not case sensitive) 

 

AccuDraw shortcuts are the same in V8i and CONNECT Edition.  
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• Now move the cursor, see that the dimensions in the AccuDraw window are following the cursor and 
that when the cursor moves near to an axis a white guideline appears. What you are actually moving is 
the start point for the block.  

For example, to place a block 300 x 300 away from the first snap point enter 300 into both AccuDraw window fields 
and accept with the data button. The first point of the block will now be 300 x 300 away from the start point.  

This can be used in sequences, in the example above the start point of the block is placed relative to a point, the 
opposite corner of the block could be placed relative to another point with a similar sequence. It takes a little getting 
used to but once you have become familiar with the sequence offset can save a lot of copying around of elements 
and eliminates the need for most construction lines.  

Snaps  

AccuDraw has several shortcuts to temporarily override the current Snap Mode. 

• Intersect snap, press I. 
• Centre snap, press C. 
• Keypoint snap, press K. This will bring up a small dialogue box where the number of keypoints can be 

changed.  

 

The override will revert to the current Snap Mode once the current snap action has been accepted.  
e.g. place a line with Keypoint as your current Snap Mode, use AccuDraw I to override to Intersect snap, snap to the 
intersection, accept that snap and the snap will immediately revert to Keypoint. 

Rotating the Compass  

The compass can rotate to align with the normal orthogonal grid but can also be rotated in several ways to other 
grids that relate to buildings or other real world features. 

Rotating the Accudraw grid.  

When drawing objects that are not aligned to a normal grid, e.g. existing buildings, the compass can be rotated to 
the desired alignment. This can be done either temporarily for a single operation or set for a series of operations. 
These take a little getting used to but once you get the sequence right are very useful. 

RE 

This rotates the compass to align with an existing element. Type RE then click on the element that you wish to align 
with. 

Also available are the RA and RQ shortcuts but these are largely superseded by RE and the use of ACS tools. 

  



 

MicroStation V8i and CONNECT Side by Side 

MicroStation V8i and CONNECT Side by Side 

Author: Marc Thomas - 10 January 2023  30 of 33 

RA 

RA does two things, it either rotates AccuDraw to the active ACS, if there is one, or allows you to to set rotation for a 
series of operations. RE is quicker and easier to use in most cases.  

Enter a data point at one end of the element whose orientation you wish to match, type RA, when prompted, snap 
again to the same point, then snap to the other end of the existing element and accept with the left button. The 
compass will remain in this orientation until either another RA is executed or any of V, T, F, S and E are used to 
rotate the compass back to normal x,y (,z) orientation. 

RQ 

To set rotation for a single operation enter a data point, type RQ and then snap to another point to define the 
rotation. This rotation will persist until the next time the reset button is pressed.  

BR Base Rotation 

As far as I can see this has some use in 3D. If you have used RQ or RA this returns to the plan that you are working in. 
i.e. if you were in the F rotation when you used RQ to do a quick rotate in that plane, BR will unrotate you back to F, 
whereas pressing T, V or E will take you to another plane. Worth playing with. 

# - Bump Tool Setting 

Many tools have options available in the tool settings window. These can be changed by pressing the # key saving a 
mouse movement away from the drawing up to the tool settings window 

For example when using SmartLine the # key will toggle the element type setting between Line and Arc allowing a 
very easy change from one to the other. 

Note this has been changed from the Bentley default of ~ because # is easier to use on European keyboards (~ is 
Shift + # over here). 

Custom AccuDraw Shortcuts 

These are no longer of much use as Position Mapping is better and far more flexible. Any attempt to produce a 
rational system of additional AccuDraw shortcuts ran into the obvious limitations of a 26 letter alphabet and the 
difficulties inherent in matching this limited supply of characters to tools in any meaningful way. 

Combining AccuDraw functions  

Any of the AccuDraw shortcut keys can be used in sequence. For example, try O to offset an element position 
followed by I to snap the endpoint of the element to an intersection. 
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Docking 

Many dialogs can be docked, icons showing the available options will display as a dialog is dragged to the edge of the 
screen. They include the available positions and tabbed options: 

 

Once docked dialogs can be pinned as tabs: 

 

 

Docking behaviour is the same in V8i and CONNECT Edition.  
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Explorer Dialogs 

The Explorer dialog has been significantly enhanced in CONNECT Edition, the details are beyond the scope of this 
QuickStart, more information can be found in the help documentation or online via CONNECT Advisor. 

Project Explorer 

In V8i Project Explorer exposes some information about file content and project resources. 

 

 

 
 

Explorer Dialog 

In CONNECT Edition this dialog has been renamed to 
Explorer. It exposes additional information about files 
and their contents and about project resources.: 

There are many right-click menus that enable direct 
access or actions relevant to the selected item. 
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User Preferences – V8i 

From MicroStation’s Workspace menu pick Preferences where a couple of useful options are: 

Task Navigation: ensure Show navigation Tools is ticked. 

 

View Options: Tick the two boxes shown changing Selection Set Colour to Cyan (or another of your preference), 
these will override whatever colours are set in each design file giving you consistent colours.  

 

User Preferences – CONNECT Edition  

MicroStation’s File menu takes you to the Backstage; pick Settings > User > Preferences. Some useful options are: 

Help 

Turn off Use Online Help, this can speed up access to the help documents as it uses the local files. 

 

Multiple Monitors 

If you have multiple monitors MicroStation can be set to open a separate window for each monitor (up to four) that 
can be maximised to each avoiding a single window stretched across multiple monitors: 

 

View Options 

View Options: Tick the two boxes shown changing Selection Set Colour to Cyan (or another of your preference), 
these will override whatever colours are set in each design file giving you consistent colours.  
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